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Preface 
 

The Florida Department of Transportation (FDOT) has led the way in developing and 
maintaining an integrated set of signal optimization and analysis tools.  Collectively, these tools 
have contributed significantly to the productivity and credibility of Department staff at the 
central and district office levels. The importance of effective software tools has continued to 
grow as congestion management and intelligent transportation systems (ITS) functions expand 
throughout the state. 
 
The new Windows-based computing environment created a need to revisit these tools.  A 
complete redesign of the current package is required to meet the needs of the FDOT in planning, 
project development and engineering, roadway design, traffic operations and ITS.   
 
The objectives of this project were to provide the Department with improved preprocessor, 
postprocessor and communications support for traffic engineering and planning software to 
replace the existing MS-DOS versions with new versions compatible with the Windows 
environment.  
 
The product of this research is a set of productivity enhancement tools that provide a high degree 
of connectivity between existing and future design, optimization and analysis models used by 
FDOT.  The tools are integrated into a single software product referred to as the “Arterial 
Analysis Package” (AAP) version 2K. 
 
This report describes the operation of the AAP.  It provides full instructions for installation, 
setup and operation of the program.  It is essentially the user’s guide for the program.  The full 
contents of this report have been reformatted and incorporated into a context sensitive HTML-
based help feature that may be accessed from any point in the program.  
 
The program has been completed and is able to perform useful work for arterial signal system 
design and evaluation.  The architecture has been designed to facilitate future enhancements.  
Because of the extensive on-line help, the training requirements are minimal.  These 
requirements will be met by a post-project workshop conducted in coordination with other 
FDOT technology transfer activities. 

 
 



 

 

Table of Contents 
ARTERIAL ANALYSIS PACKAGE USER GUIDE ................................................................... 1 
1 INTRODUCTION .................................................................................................................. 1 
2 BACKGROUND DISCUSSION............................................................................................ 2 

2.1 Evolution of The Arterial Analysis Package (AAP)....................................................... 2 
2.2 Component Programs of the AAP .................................................................................. 3 

3 SETTING UP THE AAP........................................................................................................ 4 
3.1 The Installation Step ....................................................................................................... 4 
3.2 The Configuration Step................................................................................................... 6 

3.2.1 The Component Programs Tab ............................................................................... 8 
3.2.2 The Utility Programs Tab ....................................................................................... 9 
3.2.3 The Data Folders Tab............................................................................................ 10 

4 RUNNING THE AAP .......................................................................................................... 11 
4.1 Main Menu.................................................................................................................... 11 
4.2 File Menu...................................................................................................................... 12 

4.2.1 New File................................................................................................................ 12 
4.3 Edit Menu...................................................................................................................... 13 

4.3.1 The Setup (Default Parameters) Screen................................................................ 14 
4.3.2 Arterial Data Screen.............................................................................................. 16 
4.3.3 The Intersection Configuration Screen ................................................................. 17 
4.3.4 The Approach Data Screen ................................................................................... 18 
4.3.5 The Control Plan Screen ....................................................................................... 20 
4.3.6 The Actuated Controller Settings Screen.............................................................. 23 
4.3.7 Star Network Configuration.................................................................................. 25 
4.3.8 Apply To All Intersections Option ....................................................................... 26 
4.3.9 The Agency Information Screen........................................................................... 27 

4.4 The Data Menu ............................................................................................................. 28 
4.4.1 The Reapply Defaults Option ............................................................................... 28 
4.4.2 Import and Export Features .................................................................................. 28 

4.5 The Run Control Screen................................................................................................ 29 
4.5.1 The Common Tab ................................................................................................. 31 
4.5.2 The HCS Signals Tab............................................................................................ 32 
4.5.3 The TRANSYT-7F Tab ........................................................................................ 33 
4.5.4 The PASSER II Tab.............................................................................................. 34 
4.5.5 PASSER III Tab.................................................................................................... 35 
4.5.6 The CORSIM Tab................................................................................................. 36 
4.5.7 Data Validity Checks ............................................................................................ 38 

4.6 The View Menu ............................................................................................................ 40 
4.6.1 The Project Properties Screen............................................................................... 40 

4.7 The Tools Menu............................................................................................................ 41 
4.8 The Options Menu ........................................................................................................ 42 

 



Arterial Analysis Package Program Documentation   

 1

ARTERIAL ANALYSIS PACKAGE 
USER GUIDE 

 

1 INTRODUCTION 
 
The Arterial Analysis Package (AAP) was developed in the 1970s as an integrator of some 
commonly used software products that perform traffic signal timing design and evaluation. The 
AAP has evolved to keep pace with new computer platforms, beginning with the mainframe 
computer, progressing through MSDOS-based systems to the Windows-based system that is 
currently under development. The current version is referred to as AAP2K. This document 
summarizes the features of the AAP and provides instructions for its operation. 
 
The AAP offers a powerful tool for integrating the design and analysis methodology for arterial 
traffic control systems. It brings together several widely used software products under a single 
umbrella and connects them with a common input data scheme. The software products accessible 
from the AAP are referred to as “component programs.”  The various configurations or systems 
of intersections are referred to as “facilities.” An overview of the facilities and component 
programs supported by the AAP is shown in Figure 1. 
 

 

Figure 1.  AAP Facilities and Component Programs 
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The AAP provides access to all of the component programs that support each facility. The 
component programs are all well documented and the discussion presented herein assumes that 
you are familiar with the purpose and operation of each component program that you intend to 
use. The details, scope and limitations are summarized as follows: 
 

 Single intersections may be analyzed by the Highway Capacity Software (HCS), using 
the latest version of the Signal Operations Analysis Package (SOAP2K) as a signal 
timing design tool. Access is also provided to TRANSYT-7F and CORSIM for a more 
detailed treatment of the traffic flow. While TRANSYT-7F and CORSIM both 
accommodate complex intersections with more than four approaches, the AAP deals only 
with conventional four-legged intersections. 
 

 Two-way arterial routes with a maximum of twelve intersections may be analyzed using 
TRANSYT-7F, PASSER II and CORSIM. Depending on the component program, the 
twelve intersections may be a mixture of signals, TWSC and dummy intersections. The 
arterial route must be a two-way street at all intersections. The cross streets may be two-
way streets, one-way streets or T intersections. TWSC intersections are mapped explicitly 
into TRANSYT-7F and CORSIM.  

 
 Conventional diamond intersections are accommodated by TRANSYT-7F, CORSIM and 

PASSER III. Each of these component programs models diamond interchanges in a 
different manner. The results from each program will often be different, but each 
program has some “wisdom” to offer the designer. 

 
 Star networks include a central signalized intersection with an upstream (satellite) signal 

on each of the four approaches. The central intersection is the focus of star-network 
analysis in the AAP. The satellite intersections are recognized primarily because of their 
influence on the central intersection. Star networks are mapped only to CORSIM. 

 

2 BACKGROUND DISCUSSION 
 
2.1 Evolution of The Arterial Analysis Package (AAP) 
 
The Arterial Analysis Package provides a powerful tool for integrating the design and analysis 
methodology for arterial traffic control systems. It brings together several widely used software 
products under a single umbrella and connects them with a common input data scheme. All of 
these programs have unique data coding formats. Applying the programs individually requires 
learning their respective coding schemes and user interfaces. 
 
The AAP recognizes that the software above uses the same traffic data; the difference between 
them is the format in which the software stores the data. The AAP provides a simple, convenient 
method of data coding and automatically generates the more detailed data streams required by 
the component traffic programs.  
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The software products accessible from the AAP are referred to as “component programs,” and 
the various configurations or systems of intersections are referred to as “facilities.”   
 
2.2 Component Programs of the AAP 
 
There are five component programs that have been incorporated into the AAP, including 
PASSER II, PASSER III TRANSYT-7F, HCS Signals, and CORSIM. The component programs 
will be described briefly here. More detailed information may be found in the user 
documentation for each program. To use any of the programs effectively you will have to be 
familiar with the details of its operation. Note that the component programs are not supplied with 
the AAP. 
 
The Progression Analysis Signal System Evaluation Routine Version II  (PASSER II) is a 
macroscopic, deterministic optimization program developed to maximize timing-plan 
bandwidths on arterial highways. The Texas Transportation Institute (TTI) at Texas A&M 
University developed the original program in 1973. Since then, many updates have been made, 
the latest being PASSER II-02. TTI developed the program to overcome limitations of previous 
progression models, which were generally restricted to fixed time, two-phase signals, often with 
balanced progression speeds in the two directions. PASSER II overcame these limitations by 
being able to work with multiple-phase signals, variable speeds, and priority directional 
weighing. PASSER’s model calculates phase sequences, cycle lengths and offsets to maximize 
through bandwidth. A separate version of PASSER, known as PASSER III, deals exclusively 
with diamond interchanges. 
 
Traffic Network Study Tool (TRANSYT) was developed in England by Dennis Robertson of the 
Transport and Road Research Laboratory. In 1980, the University of Florida Transportation 
Research Center was awarded a contract to develop an American version of the program. 
TRANSYT-7F was the result. TRANSYT-7F is a macroscopic, deterministic optimization model 
with time-scan simulation. The optimization algorithm is based on a hill-climbing technique. Hill 
climbing is accomplished by varying offsets and splits in time increments called “steps” and 
calculating the resulting effects on traffic. TRANSYT-7F offers several optimization objective 
functions. The Disutility Index (DI) is the default objective function. The default DI is a 
combination of minimizing both delay and stops. Other objective functions include progression, 
Progression/DI, queuing ratio, queuing ratio/DI, throughput, and throughput/DI. The current 
release of TRANSYT-7F (Release 9.6) includes many enhancements that may be invoked 
through its own interface. 
 
HCS2000 was developed by the McTrans Center at the University of Florida. The Highway 
Capacity Software (HCS) implements the procedures defined in the 2000 Highway Capacity 
Manual (HCM2000), which is Copyright 2000 by the Transportation Research Board (TRB). 
Single intersections may be analyzed by the HCS using the Signal Operations Analysis Package 
(SOAP2K) as a signal timing design tool. The HCS accommodates pretimed and actuated signals 
as well as two-way stop control (TWSC) and all-way stop control (AWSC) intersections.  
 
CORSIM is actually the combination of two models, FRESIM and NETSIM. FRESIM and 
NETSIM are microscopic, stochastic simulation models for freeway and urban traffic 
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respectively. The combination, CORSIM, is for corridor-microscopic simulation. The CORISM 
model is able to address fluctuating traffic demand at a detailed level, by modeling time-varying 
entry volumes at boundary nodes and time-varying turning fractions at urban intersections and 
freeway off-ramps for each time period. CORSIM is implemented within the Traffic Software 
Integrated System (TSIS), Developed by FHWA over the years by several contractors. The 
current version is TSIS 5.1. 
 

3 SETTING UP THE AAP 
 
The AAP must be installed and configured before it will run. The installation and configuration 
steps will be described separately. 
 
3.1 The Installation Step 
 
The AAP runs in the Windows ™ (95 and beyond) environment. The operation has been tested 
in Windows 95, 98, ME, 2000, XP and NT. Windows 2000 and NT users must be aware of the 
restrictions that may apply to accessibility of drives and directories for storing data. You should 
consult your system administrator if you are not sure of you access privileges. 
 
The AAP uses a standard installation scheme; one that should be familiar to anyone who 
routinely installs Windows application software. Windows 2000 and NT systems incorporate 
various levels of access privileges to facilitate system maintenance. If you are installing the AAP 
in either of these operating systems, you must pay particular attention to access privileges for 
subsequent users. The overall file structure is illustrated in Figure 2.  
 

 The “AAP Program Folder” identifies the folder in which all AAP programs reside. The 
program installer must have access privileges to this folder at installation time, and at the 
time that the program is first executed. Subsequent users do not need to be able to write 
files to the AAP program folder. 

 
 The “AAP Working Folder” identifies the folder in which the AAP must write its 

working files, including parameter files that may be changed by any user.  This folder 
must be accessible for writing data by all users.  

 
 The sample data files are set up at installation time in a folder immediately below the 

program folder. These are “read only files and should not be modified, otherwise their 
contents will not match the documentation. 

 
The AAP-Program and Working folders must be specified at the time of installation: 
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Figure 2.  AAP File Structure and Relationships 
 
The AAP runs in the Windows ™ (95 and beyond) environment. The operation has been tested 
in Windows 95, 98, ME, 2000, NT and XP. Windows 2000, NT and XP users must be aware of 
the restrictions that may apply to accessibility of drives and directories for storing data. You 
should consult your system administrator if you are not sure of you access privileges. 
 
The AAP uses a standard installation scheme; one that should be familiar to anyone who 
routinely installs Windows application software. Windows 2000 and NT systems incorporate 
various levels of assess privileges to facilitate system maintenance. If you are installing the AAP 
in either of these operating systems, you must pay particular attention to access privileges for 
subsequent users. Two AAP-specific folders must be specified at the time of installation: 
 
After the program has been installed, users will have full flexibility to change the location of 
their data files. Some users will want to set up several data folders to accommodate different 
projects, clients, etc. If you are using Windows 2000, XP or NT, it is your responsibility as a user 
to ensure that you have access privileges to whatever folders you decide to use for your data. The 
AAP is no different than any other Windows 2000, XP or NT application in this regard.   
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3.2 The Configuration Step  
 
The configuration step is carried out the first time the AAP is executed. On the first run it 
searches for a file called AAP2K.INI in the program directory. If this file is not found, the "First 
Time Installation" procedure is invoked. When this procedure has been completed, the 
AAP2K.INI file will be written to the program folder and the AAPSetup.par file will be created 
in the working folder. 
 
The first-time installation procedure begins with the following dialog box. 
 

 
The configuration step requires the selection of a working folder. The working folder is central to 
the operation of the AAP. This folder contains the default operating parameters, temporary data 
files, log files generated by the various mapping routines, etc. All AAP users must have 
read/write access privileges to the working folder. It is not possible to change the working folder 
after the installation has been completed, except by deleting the AAP2K.INI file and reinstalling 
the program. 
 
The working folder defaults to a folder called Working under the AAP program folder. You may 
select a different folder using the browse button, but only existing folders may be selected in this 
manner. 
 
A check box is provided on the first-time installation form that instructs the program to search 
for installed versions of the component programs. For this reason, it is better to install the AAP 
after the component programs have been installed and tested. 
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When you have selected the working folder, click the Setup button. The AAP setup will proceed 
as follows: 
 

1.  A Samples folder will be created under the program directory, and the sample data 
files will be copied to that folder. 

 
2. A Working folder will be created under the program directory, unless an existing 

folder was specified on the first-time installation screen. The initialization and 
parameter files will be copied to the working folder. 

 
3. An initialization file AAP2K.INI will be written into the program directory. This file 

contains the name of the working folder that the AAP will use to store parameter files 
and other files that must be created during normal execution. There are several of 
these files including log files that are generated by the routines that map the AAP data 
into the component programs. 

 
4. The AAP File Locations screen will be displayed.  

 
The File Locations screen is very important to the operation of the AAP. The entries on this 
screen tell the AAP where all of your component programs, utility programs and data files are 
located. The File Locations screen has three tabs, each of which will be discussed separately. 
 
The first-time selection of programs and folders will take some time. Hopefully, future versions 
of this program will streamline this process. When you have a complete set of specifications, you 
may save it by clicking the Save To button, and specifying a filename. You may restore the 
settings from any file by clicking on the Restore From button. This will allow different users to 
establish their own parameters with a minimum of effort. 
 
On subsequent runs, the AAP main menu screen will be displayed without the first time setup 
screens. You may return to the file selection display and edit screen at any time by choosing the 
Options ... File Locations item from the main menu. More information on this menu item is 
provided later in this document. You will probably want to refer to the on line help as you select 
the various files. Just click the Help button or press the F1 key for this purpose. 
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3.2.1 The Component Programs Tab 
 
The first tab is the Component Programs Tab. From here you can select the location of the .exe 
files belonging to the component programs. Pressing the Browse key will bring up a file 
explorer. 

 
If you requested the component program search, you will see some entries. Otherwise, none of 
the component programs locations will have been specified at this point. Each of the component 
programs to be connected to the AAP must be located by clicking the associated Browse button. 
If you do not have a particular component installed on your system, you will not be able to 
connect it to the AAP.  
 
The entries shown in the sample screen below reflect the default locations that will be suggested 
at the time that each of the component programs is installed. 
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3.2.2 The Utility Programs Tab 
 
The second tab is the Utility Programs Tab. From here you can select the location of the editing 
programs belonging to the component programs. Generic editing programs such as Notebook can 
also be used. Pressing the Browse key will bring up a file explorer. 
 

 
Several commercial programs are available for viewing and editing the component programs, 
and may be connected to the AAP by browsing for their location on this screen. This screen lets 
you make your own choices. Note that the first item in this list is the text editor that was selected 
on the First Time Installation Setup Screen. 
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3.2.3 The Data Folders Tab 
 
The last tab is the Data Folders Programs Tab. From here you can select the location of all the 
data files you create or access. They are arranged according to what component program you are 
using. Pressing the Browse key will bring up a file explorer. 
 

 
The data folders specification screen allows you to select a different folder for storing each of the 
data types used by the AAP. The first item on the list is the location for storing the AAP data 
itself. This choice defaults to the Samples folder that was created as a part of the installation 
process.  All other folders default to the Working folder that was created during the installation 
process. You may make your own choice of folders here. Note that the folders to be selected 
must have already been created using the Windows Explorer. 
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4 RUNNING THE AAP 
 
The balance of this document provides instructions for running the AAP. All of the information 
contained here is also available as online help, which may be accessed by selecting “Help” from 
the menu bar, clicking the “Help” button on each screen, or pressing the F1 Key. 
 
4.1 Main Menu  
 
This is the main menu window, which contains the features found in most Windows programs. 
From this screen you can select from the pull-down menus and choose the task you want to 
accomplish. Each of the menu selections will be described individually. 
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4.2 File Menu  
 

The following screen shows the File pull-down Menu. 
 
The file operations are performed on the AAP 
database and may be accessed at any time. The 
AAP database resides in a specially assigned block 
of memory that is preserved at all times. It is saved 
on disk as a random access file with an ".a2k" 
extension. 
 
The submenu choices should be familiar to all 
Windows program users. The creation of a new file 
is specific to the AAP and will therefore be 
explained in more detail.  
 
4.2.1 New File  
 
Creating a New A2K file 
 
This item clears memory to establish a new problem. Selecting this submenu item displays a 
dialog box that contains the entries and options that may be made.  
 
The following screen shows the options 
available when creating a new A2K file.  
 
Facility Type 
 
AAP 2K lets you choose between four 
different facilities.  

1. Intersection 
2. Arterial 
3. Diamond Interchange  
4. Star Network 

 
Depending on the facility chosen, the 
following options may differ. 
 
Number of Intersections 
 
You can choose up to 12 intersections in an Arterial facility. On the other facilities, the number 
of intersections is selected automatically. 
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Arterial Orientation 
 
The orientation of the arterial is very important to the logic of the AAP. All movement-specific 
data (volume, saturation flow rates, etc) are entered with directional designations. The AAP will 
automatically choose the proper bi-directional approaches to link together to form an arterial 
route. For example, if East-West is selected, then all the east-west approaches will be put 
together in the proper sequence. The AAP assumes the facility is linear. If you have a route that 
is not, some of the intersection orientations may have to be manipulated. 
 
North-south arterial routes are assumed to proceed in the northbound direction. In other words, 
the first intersection will be at the south end. East-west routes are assumed to be eastbound, with 
the first intersection at the west end. This is an important consideration for planning your 
subsequent data entry. 
 
4.3 Edit Menu  
 
This is the Edit pull-down menu screen. This 
menu item allows access to the edit screens for 
all AAP Data. The submenu choices are shown 
below and are discussed separately. All of the 
screens will be discussed, but only the edit 
screens that are appropriate to the facility type 
will be enabled on the edit menu. 
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4.3.1 The Setup (Default Parameters) Screen 
 
This is the AAP Data Setup Screen, which sets up the default values to be applied to all 
intersections on the facility. The application of default values will facilitate the entry of 
intersection, approach, and movement specific data later. 
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This screen is divided into three frames as follows: 
 
The Global Defaults Frame 
 
Global default valued may be applied separately to the arterial (forward. and reverse. directions) 
and the cross street (common to both directions).  
 
The Common Model Parameters Frame 
 
This frame contains the operating parameters that are common to all component programs, 
including  

• The analysis period (15 Min to 1 Hr) 
• Startup Lost Time 
• Cycle Range 
• Sneakers 
• Effective Green Extension 
• External Link Length (will be mapped to all approaches external to the arterial) 
• Lane Width for left and thru lanes  
• Central Business District  (CBD) or not?, indicated by a check box 

 
The Control Parameters Frame 
 
This frame contains the default minimum and maximum green times for the left and through 
movements. For actuated control, the allowable gap and detector lengths may be specified. The 
left turn protection can also be selected as well as RTOR treatment. The “optimize phasing” 
option applies only to PASSER II.  
 
Control Mode 
 
A pull-down list offers a selection between pretimed and actuated (isolated dual-ring and 
coordinated dual-ring) control modes. 
 
Max Green Multiplier 
 
This parameter is used to compute the maximum green times per phase for traffic-actuated 
control. The multiplier expands the specified green time for a pretimed phase to be used as the 
maximum green time for a traffic-actuated phase. The value of 1.0 on the above screen will 
produce no expansion. In other words, the specified green time would be set as the maximum 
green time. This parameter may be edited for each intersection on the Control Plan screen 
 
Command Buttons 
 
Command buttons are provided to save and restore default values to and from this screen. The 
OK button will exit the screen and apply the default values to all approaches, movements, etc. on 
the facility. The Cancel button will exit without applying defaults. You will not be able to 
proceed with further data entry if you cancel this screen. 
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4.3.2 Arterial Data Screen  
 
The following edit screen is displayed when this item is selected. 
 

 
The numbers along the left side of the screen are fixed numbers. They represent the intersections 
from 1 to 12 in ascending order beginning with the first intersection proceeding in the arterial 
orientation chosen in the new data window. The intersecting street names can be entered and 
edited from this screen, as are the reference numbers. The reference numbers are provided for 
agencies that assign unique numbers to each intersection. 
 
All speeds in the forward direction initially default to the system speed, but these may be 
changed on an individual basis. The link lengths, however, cannot have defaults. These must be 
entered individually, by intersection, for the forward direction. The "Apply to Westbound 
(Southbound)" button automatically enters the speeds and distances for the reverse direction. 
You can also individually edit these by pressing the 
Westbound (Southbound) tab. You may need to edit the 
reverse direction information because of variations in 
speed between the two directions, or because of unusual 
link geometrics that could cause different lengths in 
different directions.   
 
Control Tab 
 
This is the Control Tab screen. From this screen you can 
also choose which intersections are going to be optimized 
and which ones are to be dummy intersections. Phasing optimization is applied to PASSER II 
only, and dummy intersections are mapped only into CORSIM. A dummy intersection in 
CORSIM simply establishes a node with no cross street activity. This facilitates the entry of 
special features, such as lane drops, using the CORSIM editor.   
 
Note that the current version of TRANSYT-7F has some phasing optimization features that may 
be invoked from its own user interface. 
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4.3.3 The Intersection Configuration Screen 
 
The following window appears when the "Intersection Configuration" submenu is chosen. The 
basic layout of the intersection can be modified from here. 
 

 

In the "Basic Layout Box" on the left, you can select between a full intersection, T-intersections 
or one-way intersections on the cross street. The arterial must have all of its approaches present. 
 
The check boxes in the configuration diagram are used to establish that a movement exists.  
 
From here the number of lanes and turning bays can be specified. The length of the right turn and 
left turn bays can also be specified. The default values are automatically placed in the 
appropriate boxes.  
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4.3.4 The Approach Data Screen  
 
The following edit screen is displayed when this item is selected. 
 

 

Approach Characteristics 
 
These characteristics have been transferred from the Setup screen. All fields may be edited here 
except the lengths of the arterial approaches, which are taken from the Arterial Data screen. Each 
Tab represents one of the four approaches at the intersection. 
 
Movement Data 
 
The directional approaches are fixed. The turning movements are Left, Thru and Right. The 
numbers below the movements are NEMA phase numbers that are sensitive to the orientation. 
 
The "Volume", "Free Turns" and "PHF/Pk15 Min Vol" can be entered directly into the screen. 
The "Adjusted Volume" is calculation of these three values, using the growth factor for the 
approach. 
 



Arterial Analysis Package Program Documentation   

 19

The "Saturation Flow Rate" has been inserted from the Setup Screen. The "Adjusted SatFlow" is 
calculated by multiplying this value by the number of lanes and adjusting for right turns. These 
values will be mapped directly to the component programs. 
 
Origin-Destination Matrix 
 
Traffic may enter a typical link as a through movement or as a right or left turn from the 
upstream intersection. It may then leave the link at the downstream intersection with the same 
options. This creates a matrix of nine possible origin-destination (OD) combinations. Models that 
treat the flow of traffic in discrete time steps must make assumptions about the nature of this 
matrix. Different models make different assumptions, thereby introducing systematic differences 
in their results.  
 
For internal links (i.e., those with both an 
upstream and downstream intersection on 
the arterial) the percent of traffic entering 
and leaving as turns may be specified in the 
OD Matrix frame of this screen. As shown 
here, the nine cell matrix has been reduced 
to four cells by assigning all traffic that 
does not turn left or right to the through 
movement. 
 
The box is located on the lower left side of the Approach Data Screen, and can only be seen 
when the “Use Default O-D matrix” check box is not selected. 
 
Some caution must be used when entering these relative volume values. It is important to make 
sure that the sum of the rows (ie From LT-To LT plus From LT-To RT) is equal to or less then 
100, otherwise a negative value could be applied to the through movement percentage.  
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4.3.5 The Control Plan Screen 
 
The following window appears when the "Control Plan" submenu is selected. The timing plan 
consists of a specification for the sequence, phase lengths, and offset at each intersection. 

 
Controller Operation Mode 
 
This pull-down menu allows you to select between pretimed, actuated (isolated and coordinated), 
Two-Way Stop Control and All-Way Stop Control.  When the Actuated Control Mode is chosen, 
the Edit Actuated Control Settings button appears and can be selected. 
 
Traffic Engineering Decisions 
 
The signal phasing is not entered explicitly, but is derived by the AAP from the traffic 
engineering decisions that must be made for each movement. These decisions include 

• Type of left turn protection 
• Whether or not phase overlap is allowed (i.e., must leading left turns terminate at the 

same time?) 
• Position of the left turn in the sequence (leading or lagging) 
• Right turn treatment 
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The pull-down menu allows you to select left and right turn treatments. You can also select the 
order of your left turns (lead or lag).  
 
Turn Treatments 
 
The left turn treatments include: 

• Permitted 
• Protected 
• Protected/permitted 
• Not opposed. 

 
The “not opposed” treatment applies to one-way streets, T intersections and Split phasing. In 
these cases, the left turns are always able to proceed with the through traffic without having to 
yield to oncoming traffic. 
 
The right turn treatments include: 

• RTOR 
• No RTOR 
• Overlapped with a shadowing left turn (e.g., the NBRT would have a green arrow 

display with the WBLT) 
• Free 

 
The right turn treatments are mapped differently into each component program depending on its 
ability to model each of the treatments. Free right turns are not mapped explicitly into any of the 
programs. In most cases, the right turn volumes are simply ignored for free tight turns. 
 
Phasing Plan 
 
The phasing plan is synthesized automatically from the traffic engineering decisions. 
 
The phasing is represented by a table indicating the display given to each approach on each 
phase. The display codes include: 

• L = Left only  
• T = Through only (the right turn is assumed to proceed concurrently) 
• R = Right only: used only for right turns overlapping a shadowing left turn  
• G = Green: all movements allowed with the left turn yielding to oncoming traffic 
• U = Unopposed: all movements allowed with no opposing traffic for the left turn 

 
The box at the right depicts a common scenario for 8-phase traffic actuated control, indicating 
that: 

• The first phase accommodates the NB and SB lefts  
• The second phase accommodates all NB movements 

with no opposition for the left turn. In other words, 
the SBLT has yielded control to the NB through 
traffic  
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• The third phase accommodates the SB thru (and RT), as well as the all NB movements 
with no opposition for the left turn. 

 
This table is consistent with the traffic engineering treatments indicated on the control plan 
screen shown previously for the NB and SB movements. The third phase shows different 
displays for NB and SB because of different left turn treatments indicated for these approaches. 
 
Close examination of the EB and WB control plan data indicates that, even though the “overlap 
allowed” box was checked for the EB and WB approaches, there are only two phases shown in 
the E-W phasing plan. This would indicate that the difference in the left turn volumes for the two 
directions was not sufficient to assign an overlap (i.e., “U”) phase.  The important lesson here is 
that, to take advantage of this feature, the traffic volumes must be specified on the Approach 
Data screen. Before the control plan is selected. 
 
Timing Plan 
 
Separate fields are provided for entering green, yellow and all-red (indicated by “AR”) intervals. 
The green intervals must be entered for each phase. The yellow and all-red intervals are pre-
selected from the global defaults values entered on the Setup screen, but may be edited here. The 
cycle length is computed automatically as the sum of all intervals. Note that changing the 
number of phases will require reentry of green times for some phases. 
 
Offset 
 
For coordinated operation the offset must be entered for each intersection. For purposes of 
mapping this data to the component programs, the offset is defined by the AAP as the elapsed 
time in seconds from the system reference time to the beginning of the first arterial phase. 
 
Max Green Multiplier 
 
This value is used in determining the maximum greens per phase for traffic-actuated control. The 
maximum green values for each phase will be determined by the specified green times, using the 
maximum green multiplier. The default value is 1.0, which indicates that the specified green 
times will be used as maximum green times if the intersection is actuated.  
 
Maximum green times may also be entered individually for each phase on the Actuated Settings 
screen. 



Arterial Analysis Package Program Documentation   

 23

4.3.6 The Actuated Controller Settings Screen 
 
This screen is only accessible from the Control Plan screen, and only when a traffic-actuated 
control mode has been selected for the intersection. Traffic-actuated control is mapped explicitly 
to CORSIM only. The following window appears when the "Edit Actuated Controller Settings" 
button is selected on the Control Plan screen. 
 

 

The eight phase numbers and their corresponding movements are located on the left side of the 
screen. All of the eight phases are represented on the screen shown here, indicating that all left 
turns are protected, and therefore all phases are required. All phases that are not required by the 
left turn treatment for their associated movement will be disabled on this screen. 
 
Phase Recall 
 
Next to the movement designation is the "Recall Mode" pull-down list. The recall mode can be 
set as None, To Minimum, To Maximum or To Ped Phase. 
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Unit Extension 
 
The unit extension represents the gap between vehicles that will cause the associated phase to 
terminate. This is a universal parameter found on all traffic controllers. Defaults values are 
transferred to this screen from the Setup screen, and may be edited here.  
 
Maximum Green 
 
The maximum green setting for each phase may be entered here. If this field is left blank, or a 
zero value is entered, the maximum green time will be computed from the specified green time 
and the Max green multiplier entered on the Control Plan screen. 
 
Detector Properties 
 
Under this tab, the screen that appears allows the Length, Setback, Delay, and Carryover 
properties to be edited for each individual detector. These values are mapped directly to 
CORSIM. A default value is automatically inserted for the length from the Setup screen. 
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4.3.7 Star Network Configuration  
 
The following edit screen (next page) is displayed when this item is selected. 
 
Star networks include a central signalized intersection with an upstream (satellite) signal on each 
of the four approaches. Only CORSIM, can accommodate star networks. The central intersection 
is the focus of star-network analysis in the AAP. The satellite intersections are recognized 
primarily because of their influence on the central intersection.  
 

 

There is no data to be entered on this form. It is provided to simplify the selection of 
intersections for further data entry and editing. Clicking on one of the intersection buttons takes 
you directly to the Intersection Configuration submenu. 
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4.3.8 Apply To All Intersections Option  
 
This feature copies information from the currently selected intersection to other intersections. It 
applies to the Intersection Data, Approach Data and Control Plan screens. On the Approach 
Data screen, only the movement data will be copied to avoid disturbing approach lengths, etc.  

 
All intersections can be selected and cleared by using the check boxes on the left or the buttons 
on the right of the screen. Note that it is not possible to de-select the current intersection because 
the data values have already been applied to that intersection. 
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4.3.9 The Agency Information Screen 
 
On this screen, you can enter pertinent information about your organization. The AAP maps this 
information to the component programs as appropriate.  
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4.4 The Data Menu  
 
This is the Data Pull-down Menu screen. This menu item allows you to manipulate data within 
the AAP. The submenu choices are shown below and are discussed separately.  

 
4.4.1 The Reapply Defaults Option  
 
This option displays the Setup screen and allows you to modify and reapply all of the default 
parameters to each approach, movement, phase, etc. If you reapply the defaults, you will return 
all data fields to their default values and destroy all data entry that was made since the default 
values were last applied. The following warning message will be displayed to give you one last 
chance to change your mind. 

 
4.4.2 Import and Export Features  
 
The function of these two features is to import and export data in XML format from other 
programs that offer this format. The import and export features are primarily a provision for 
future expansion of the AAP functionality  
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4.5 The Run Control Screen  
 
The Run Control screen contains instructions that control the component program execution. The 
screen is divided horizontally into three sections: 
 
The top section contains the scoping parameters common to all runs. A frame is provided for the 
selection of intersections to which the run should be applied. The options are one intersection, all 
intersections or a range of contiguous intersections. The cycle length range is also specified in 
this section.  
 

 
The center section contains a tab control that shows the run-specific parameters. The example 
screen above shows the parameters common to all component programs. The run parameters for 
each component program will be discussed separately. 
 

 
The bottom section contains a set of command buttons and a comment line. The comment line 
will be mapped to all of the component programs that accept comment lines. 
 

 
The command buttons perform the following functions: 
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Run Control Screen Command Button Functions 
Check Performs a data validity check for the selected component program, but 

does not run the program 
Run Maps the data for the component program, runs the computational 

engine for the program and lists the outputs if requested 
Transfer Data Maps the data for the component program and runs the user interface for 

the program. The computational engine may be run from the user 
interface. Each of the component programs deals differently with this 
procedure. Some programs load automatically, while others require you 
to browse for the data 

Main Menu Saves the most recent run control parameters and returns to the main 
menu 

Cancel Returns to the main menu without saving the most recent run control 
parameters. 

Help Invokes the help display for this screen. The help feature may also be 
invoked from the menu bar, or by pressing the F1 key. 

 
The treatment of the “Run” and “Transfer Data” commands among the various component 
programs is summarized as follows: 
 

Component Program Treatment of “Run” and “Transfer Data” Functions 
Program Run Transfer Data 

HCS Not supported by component 
program. 

Data file is loaded automatically, and 
may be modified before running the 
program 

TRANSYT-7F Enabled for evaluation runs 
with specified timing. Runs 
the computational engine 
directly 

Data file is loaded automatically, and 
may be modified before running the 
program 

CORSIM Enabled if the RUNCOR 
program has been installed. 
Runs the computational 
engine directly, using 
RUNCOR 

Data file is loaded automatically, and 
may be converted to a “network” file for 
the TSIS editor. A project file is also 
created to enable the data to be opened in 
the TSIS explorer frame. 

PASSER II Not supported by the 
component program.  

Data file must be loaded using the 
component program’s “Open File” 
command. The browser window must be 
set to search for “.DAT” files.  

PASSER III Not supported by component 
program. 

Data file must be loaded using the 
component program’s “Open File” 
command. The browser winfow will 
automatically search for “.P3I” files 

 
The component programs shown in the different tabs will be discussed separately. 
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4.5.1 The Common Tab  
 

 
The common tab window contains data items (mostly labels) that will be passed to the 
component programs that have input fields for this information. There are also two check boxes 
that determine whether the input and output data will be displayed automatically before or after 
running the component programs. The input data would normally be displayed for debugging 
purposes, or to facilitate minor editing before the file is passed on to the component program. 
The output data display works only with the “Run” command. You must use the View menu to 
see the outputs of programs executed by the “Transfer Data” command. 
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4.5.2 The HCS Signals Tab  
 

 
The AAP data may be transferred to the HCS by selecting a the desired intersection from the 
arterial route and clicking the “Transfer Data” command button. Only signalized intersection 
data may be transferred in this manner. The transfer of TWSC data to HCS is not supported.  
 
The only program specific data that may be entered on this screen is the analysis year. This field 
is optional and may be left blank. 
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4.5.3 The TRANSYT-7F Tab  
 

 

TRANSYT evaluates or optimizes your signal-timing plan depending on the action you select. If 
the optimization box is checked, then the minimum and maximum cycle times must be specified. 
If the evaluation box is checked then the single cycle box on top of the screen is automatically 
checked and a single cycle length is used. All timing data must be entered for the evaluation 
mode. 
 
The type of simulation the TRANSYT engine runs can also be chosen using the pull-down menu 
labeled "Simulation Type". You can choose between single-cycle linkwise, single-cycle stepwise, 
or multi-cycle stepwise. You may also select two options using the check boxes at the left side of 
the screen: 
 

• The “Wide Output Format” option will deliver the output in a more detailed format. This 
option adds significantly to the size of the output file, but offers more data and more 
complete descriptions of the dada items. 

 
• The “Treat Turn Bays as Short Links” option is suggested by the TRANSYT 

documentation to model turning bays more realistically, but it produces several warning 
diagnostics about unequal link lengths. 
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4.5.4 The PASSER II Tab  
 

 
PASSER II offers several parameters that control its optimization and evaluation. Default values 
are mapped for most of the PASSER II-specific data items. These values may be changed using 
the PASSER II user interface for increased control over the modeling process. 
 
The three most commonly used parameters that are unique to PASSER II may be specified in 
this tab window before the component program data file is created. 
 
• The “Optimize Sequence” check box will request a sequence optimization. The sequence 

optimization may be disabled at selected intersections using the check boxes provided on the 
control tab of the Arterial Data screen  

• The “Min Forward Band” controls the balance between inbound and outbound progression. 
Please refer to the PASSER II documentation for details on this parameter. 

• The “Progression Speed Search” check box invokes a feature in PASSER II that searches for 
the best progression within a 2 mph range of the specified travel speeds. 

 
The design of PASSER II is such that its computational engine must be launched from its own 
user interface 
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4.5.5 PASSER III Tab  

 
Data for diamond interchange facilities may be transferred to the PASSER III user interface. The 
only parameter needed in addition to the normal AAP data is the name of the freeway. The 
design of PASSER III is such that its computational engine must be launched from its own user 
interface. 
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4.5.6 The CORSIM Tab  

 
The CORSIM simulation engine can be launched either directly or through TSIS. One of the 
benefits of running the file through TSIS is the ability to convert the text file (.trf) into a network 
file (.tno) for editing by the TSIS editor program.  
 
The CORSIM-Specific parameters that may be entered or selected on this screen include: 
 
• The Free Speed Factor:  The CORSIM definition of speed differs from the other component 

programs.  The speeds entered on the approach data screen are mapped into TRANSYT-7F, 
PASSER II and PASSER III as actual running speeds. As such, they represent the average 
speed of vehicles for progression computations. The speed value required by CORSIM is the 
“free-flow” speed. This value represents the speed at which vehicles will travel when they 
are not constrained by slower vehicles in front of them. CORSIM establishes a stochastic 
range of speeds around the free flow speed such that there will always be slower vehicles that 
will cause the average speed to be lower than the free flow speed. So, to produce comparable 
results between CORSIM and the other models, it is necessary to provide CORSIM with a 
slightly higher speed value. A lower average speed will be produced implicitly by the 
modeling process. The default value is 1.2. Lower values may be appropriate under very light 
traffic conditions. 

 
• The “NEMA” controller check box:  CORSIM offers traffic control emulation for the two 

most common traffic actuated control standards (NEMA and Type 170). This check box 
determines which standard will be invoked. 
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• The “Output Level” pull-down list allows you to reduce the volume of text produced by 
CORSIM, thus simplifying the interpretation of outputs for many purposes. The output level 
choices are: 

o All outputs 
o Suppress inputs 
o Suppress details 
o Suppress both 

 
• The “Create New Directory” checkbox facilitates conformance with the TSIS convention of 

keeping a separate directory (i.e., folder) for each CORSIM project. If this box is checked, a 
new directory will be created with the same name as the data file if one does not already 
exist. A TSIS project file (.tcf) will be placed in that directory. This will make it easier to 
organize your TSIS projects in the TSIS explorer pane. All directories will be created as 
subdirectories of the folder selected on the “options” screen for TSIS data. If this box is not 
checked, the project and data files will be placed in the CORSIM data folder itself. 



Arterial Analysis Package Program Documentation   

 38

4.5.7 Data Validity Checks 
 
The Data Validity Checker (DVC) is launched from the Run Control screen. Its purpose is to 
check the data file for any inconsistencies and/or errors. With each component program selected, 
the DVC knows which specifications to look for. It then checks the data and gives a warning or 
an error message, depending on the severity of the problem.  
 
The data utility checker makes sure that the following objectives are followed. 

 The structure of the input stream is correct and that no significant information has been 
omitted. 

 The data must be valid and it must lie within a specified range. 
 The data items must be internally consistent and no items may be missing. 

 
If there is a problem in the data, a message is displayed. Each message contains additional 
information to help you locate and correct the problem. 
 
There are two different errors the DVC can find: warnings and fatal errors. Warning messages 
are caused by conditions that may or may not represent errors in the data. You should investigate 
the validity of all warning messages. Warning level problems will usually not stop the 
component programs from running, but the results of the simulation or optimization will be 
affected. Fatal errors are caused by missing or incorrect data that prevent the component 
programs from running.  
 
Examples of warning and fatal error messages are shown below. 
 

 
 

 
If the DVC identifies warning level problems, you may decide to run the component program 
anyway, or to return to the run control screen. If fatal errors are discovered, the component 
program may not be run.  The following table summarizes the DVC operation 
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Summary of Diagnostic Checks for AAP Data 
Levels: W= Warning, E = Error                
[xx] indicates example number or direction 

Common Data Checks Level Cause 
Zero link length on [WB] approach at 

Intersection [4] E Missing or zero link length 

Check PHF on the [WB] movement at 
Intersection [4] E PHF does not match time period 

for analysis 
The Grade on the [WB] approach, Intersection 

[4] does not match the opposing [EB] 
approach. 

W Two different values for the link 
grade 

Link Lengths not consistent on [WB] link on 
intersection [1] and [EB] link on intersection 

[2]. 
E Two different values for the same 

link length 

No Movements exists on [WB] approach on 
Intersection [4] E Missing movement in an existing 

approach 

Lead-lead (or lag-lag) protected turns with 
shared lanes exists on [WB] on Intersection [4] E 

Protected left-turn movements 
exist with shared lanes unless 

phasing  is lead-lag 
 

TRANSYT-7F Data Checks   
Volume must be at least 10 vph! Check [WB] 

movement on Intersection [4]  E Volumes less than ten 

Min and Max Cycle Lengths should be the 
same! Check Intersect. [4] Or try using the 

SingleCycle box. 
W Different cycle lengths when an 

evaluation is selected 

Intersection Cycle Lengths should be the same 
for Evaluation! W Cycle length between 

intersections are different 
 

CORSIM Data Checks   
Link Length on [WB]" approach on 
Intersection "[4] " is out of range (50-4000)! E Link length is out of range 

Left [or Right] turn pocket is out of range (20-
1000) on [WB] movement on Intersection [4]. E Turn bay length out of range 

Number of lanes on [WB] movement is out of 
range (1-7) on intersection [4]. E Total number of exclusive lanes 

out of range 
 

PASSER II Data Checks   
"Dummy intersections will not be recognized 
by PASSER! Check Intersection [4]" E Dummy intersections exist 

Adjusted Saturation Flow rate is needed! 
Check [WB] movement on Intersection [4]" E Missing Adjusted Sat. Flow rate 
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4.6 The View Menu  
 
Using this menu you can view the results from the 
different component programs (HCS, TRANSYT, 
PASSER II, PASSER III, and CORSIM). You will 
be asked to select the file to be viewed using a 
standard dialog box. The selected file will then be 
opened in the application specified on the Utility 
Programs tab of the File Locations screen under the 
Options menu.   
 
Other choices on this list include Project Properties 
and Run Log.  
 
4.6.1 The Project Properties Screen 

 
The Project Properties screen gives you a read-only overview of the most important attributes of 
the current data, such as file name, type of facility and orientation. 
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4.7 The Tools Menu  
 
The tools menu provides access to three tools that support the AAP 

• ArtPrep, a quick entry editor that uses planning level data to synthesize an AAP file 
for an arterial facility 

• The Traffic Model Results Comparison (TMRC) program, that provides an intelligent 
comparison of two arterial data files in XML format. 

• A general comparison utility that quickly spots small differences between two text 
files. Several choices are available on the market. One such choice is Microsoft 
WinDiff. You must procure and install your own comparison utility, and establish the 
location of the file on the Utility Programs tab in the File Locations screen on the 
Options Menu  

 
When you choose the Comparison Utility tool, you will see the following screen, assuming that 
you have installed a comparison utility program: 
 

 
The two files for comparison may be identified using the Browse buttons. The browser will start 
looking in the data file folder for whatever component program you have selected from the pull-
down list. When both files have been selected, the Compare command button will be enabled 
and you will be able to launch the comparison utility at that point. 
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4.8 The Options Menu  
 
The following screen is the Options Pull-down menu. From here you can modify the locations of 
your files and component programs. For future expansion of the AAP, an Add Ins button has 
been placed on the pull-down menu. The Add Ins button is a future provision. It is not yet active 
because no add ins have been created for the AAP  
 

 
The File Locations option is very important to the operation of the AAP. This option tells the 
AAP where all of your component programs, utility programs and data files are located. The File 
Locations screen is explained in detail in the “AAP Configuration” section of this document. 
 


